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UHBX-R-XT 

1. Windows™ Software Installation 

1.1. General 
The UHBX-R-XT graphical user interface (GUI) is a Windows® software used to configure 
advanced settings of the UHBX-R-XT. Use of the software requires USB connection of 
the PC to the device. For convenience, a USB cable is provided with the receiver. 

After configuring the receiver, the user can save the desired configuration as a file on 
their PC. Configuration files can also be uploaded to receiver. 

1.2. Installation Prerequisites 
• PC with Windows XP™ OS or later 

• USB port  

• Microsoft™ .NET Framework 2.0 or later (most recent OS including Windows 7 and 
8 typically include this and no action is required). If .NET Framework 2.0 or later is 
not installed on your PC, the Microsoft™ website has free downloads available.  

1.3. Installing the Software 
• If an earlier version of this software was previously installed, UNINSTALL the 

program first from either the Add/Remove Programs section of the control panel or 
by running the previous installation SETUP.EXE and selecting “remove application”. 

• Install the software by executing the SETUP.EXE program from the installation 
source directory 

• Accept the default settings, but if you want to specify a particular installation 
directory other than the default, you may do so. 

• Once the UHBX-R-XT software installation has completed, either click the desktop 
icon              

or from the Start Menu: Start  Programs  Hall Research  UHBX-R-XT 
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2. Using the Software 

2.1. General 
The UHBX-R-XT Manager is a Windows software that can be used to configure the 
HDBT receiver extender via a USB connection. 

It provides the ability to configure RS232 or IR commands. The GUI can save and load a 
configuration file into or from the device, and can be used to easily update firmware in the 
UHBX-R-XT. 

2.2. USB Device Detection 
The Manager Software automatically configures the USB port after connection to the 
device. No special USB driver installation is required by the user. 

The first time you connect the device to a PC, you may experience a short delay while 
Windows automatically installs the required USB drivers. This only happens once.  

2.2.1. USB Connection Status 
The GUI shows USB connection status and the number of detected receivers on the 
bottom right corner of the status bar. If no USB device is detected the Status bar shows a 
message indicating that the GUI is waiting for a connection as shown below. 

 GUI is waiting for USB connection to receiver 

                 GUI has detected one device connected 

2.3. Menu Pages 
There are two menu pages: 

• Status  - can be used to: 
o Display and monitor the HDBaseT® input and output 

 Notice   If you start the Manager software without the USB port 
attached, the on-screen fields are disabled (grayed out). The 
instant you connect the USB cable, the GUI fields will 
become active.  
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UHBX-R-XT 

o Display the current unit ID and the RS232 settings including its baud 
rate and parity. 

o Select an EDID mode such as an internal "emulate" or "pass-thru" 
from the display. 

o Learn an EDID from a sink LCD monitor connected to a local HDMI 
port. 

• Configuration - can be used to: 
o Define and store any RS232 (or simple IR) commands for controlling 

the display.  
o Assign a unique address for the receiver. 

2.3.1. Status Page 

 

The HDBaseT input and output have LEDs to 
indicate its Link, Video, and Long Reach status. In 
addition, the cable length is also shown when 
applicable. However, the calculation may vary 
according to cable quality. 

HDBaseT 

When the LED is on, it means the indicated status 
is detected. When it is off, its status is not present.  
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Current Configuration 
Unit address is the unique address assigned to the 
connected receiver. It is always set to 1 by default. If 
there are multiple receivers connected together in 
daisy chain, each receiver can be assigned a 
different address ranging from 1 to 99 so that it can 
be easily referenced by the sender. 

Output baud and parity are the current settings of the RS232 port, which is used to 
communicate with a projector or TV. 

EDID mode can be set to either emulate or pass-thru.  

EDID 

 Emulate – In this mode, the internal default EDID is passed to the source. 

 Pass-thru (Default) – This is a default mode. When set to this mode, the EDID 
passed to the source comes from a sink TV, LCD monitor, or projector connected to 
the receiver. 

EDID can be learned from a local HDMI monitor. The saved 
EDID will automatically replace the emulated EDID. 

 

When the input or output Link LED is flashing, it is indicating the input or 
output of the HDBaseT receiver is in Low Power mode due to either +5V 
video source or HPD sink LCD being not detected. 

 Notice   The UHBX-R-XT receiver has a Switch under the HDMI 
output connector that can change its mode between 
Auto and Long Reach modes.  
 
When set to Long Reach mode, the HDBaseT output 
will have the strongest signal from the sender to the 
receiver. However, this mode does not support deep 
color or 4K video. 
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2.3.2 Configuration 

 
 

The UHBX-R-XT allows the user to define either RS232 or optional IR commands and 
store them at 6 different locations.  

Optional IR can only be used if the exact protocol of the IR (such as RC5, NEC, etc) and 
the address and data bytes for the button are known. This information is typically hard to 
come by!  We recommend using IR only if you are 100% certain and verified that you 
have such information. Therefore, it is highly advised to use RS232 whenever possible. 
Also remember that the receiver does provide an IR emitter and for simple installations, 
the user can just point the remote to the sender and extend it to the display. 

A command can be up to 40 bytes long, and it can be a combination of serial, optional 
IR, and delay commands.  

 Location – It is used to select where a command 
is going to be stored. 

 Protocol – It consists of serial and Optional IR to 
use for a protocol. 

 Auto Power Mode – When the device is set in this mode, it will automatically issue 
power commands based on detecting video source and/or display. When both the 
video source and the display are connected, the device will send out the pre-
configured power on command at location 1. When either the video source or the 
display is removed, the device will send out the power off command at location 2. 
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 Auto Off Delay – It is only used in the auto power mode. The auto off delay is 
defined as the time the device will wait after no video being detected before sending 
out the pre-configured power off command to the display at location 2.  

After receiving a power off command, some projectors ignore further commands for 
some period of time (typically 30 seconds to a minute). We recommend that the 
user tests their projector and determines the time it needs to get ready to process 
commands. Then you can enter a time delay as part of the power off command 
string. This way, if just after sending the off command the video is reconnected, the 
switcher will wait for the inserted delay to expire before issuing the On command 
(without the Delay in the off command, the On command may not be received). 
Power 

 

Serial Commands 

 A serial command can send data to any standard serial device with selectable baud 
rate and parity. 

 Hexadecimal characters may be entered by using &h in front of the 2 digit 
hexadecimal character (e.g. &hbe&hef&h00&h00&h01). 

 Commands are entered in the command text box. When done, you can click the 
Add button to append the command as shown in the figure below. 

 

Optional IR Codes 

As cautioned above . IR can only be used if the exact protocol of the IR (such as RC5, 
NEC, etc) and the address and data bytes for the button are known. 
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 Supported IR formats are: NEC, JVC, RCA, RC5, Sony, Extended NEC, and 
Samsung.  

 Select the desired IR protocol and enter address along with command. When done, 
just click the Add button to append the command. 

 
 

Inserting Delays in Commands  

 
A time delay can be added to a command string between multiple serial or/and IR 
commands if needed.  

 
In the above example, as part of the command at location 1 the device also sends a 
Source selection to the TV after a brief delay (just in case someone had inadvertently 
switched the TV input away from the HDMI that is connected to the receiver). 
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Unit Address 

 
The UHBX-R-XT receiver can be assigned a unique address so that the sender can 
easily identify and be connected to when there are multiple receivers daisy chained 
together. 

 

2.4. Tool Bar Menu 
The UHBX-R-XT Manager toolbar consists of three main 
menus. 

The File menu consists of the Exit selection as shown. 

File 

 Exit – Exit the UHBX-R-XT Manager. 

 Load Configuration – Get an existing configuration file 

Tools 

from the PC. Configuration files are text files that 
contain all user configurations including commands, 
communication settings, auto power mode, auto off 
delay, and EDID mode …etc. 

 Save Configuration – Save the current user 
configuration as a file on PC. 

 Import EDID – Import an EDID (256-byte binary into the 
unit). 

 Export EDID – Save the EDID as a 256-byte binary file. This file can be edited and 
reloaded using Import EDID tool selection. 

Notice 

The Upload button  is used to store the current 
command strings into the receiver when clicked. 
 

The Download button  is used to recall the current 
command strings from the receiver when clicked. 
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 USB Device Name – Each receiver can 
be assigned a unique name up to 10 
characters. By default all receivers are 
called USBDEVHR as shipped but if you 
are going to configure a number of 
receivers differently, then you may wish to 
assign different names to them that 
indicate room number or configuration 
type. 

The USB Device Name window is shown above. When a name is assigned, click the 
OK button to save the name.  

 Factory Default – Restore the device to factory default settings. 

 Firmware Update – Allow you to update any future device firmware. 

 

The Help menu has the About selection as shown. 

Help 

 About… - Display the current version of UHBX-R-XT 
Manager, device firmware, and USB serial number. 
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2.5. Firmware Update 
The firmware update can be found under the Tools menu.  When the Firmware Update 
is selected, the UHBX-R-XT Manager will open a Firmware Update window as shown. 
 
It is recommended to restart the GUI after the firmware update. 
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Appendix 1 - Serial Commands  
The UHBX-R-XT will be communicating with a host through its HDBaseT input at a fixed 
baud rate of 9600 and no parity. 
 

Command Response Function 
XCn <cr> XCn <cr> Connect the host controller to a specific unit addressed by n. 

n = 01 - 99 or * (for all) 
XT <cr> XT <cr> Transmit serial bytes to the local RS232 port.  This command 

should be followed by a string of serial bytes to be sent out, and 
it is terminated by 0x17 and 0x0D 

XR <cr> x Bytes or none in FIFO Read the last bytes received in FIFO at the local RS232 port. 
The unit normally stores only the last 64 

XBn <cr> XBn <cr> Set baud rate for the local RS232 port.   
n = 1 - 8 = 1200 – 115200 

XPn <cr> XPn <cr> Set parity for the local RS232 port.   
n = 0 - 2 = None, Odd, and Even 

XSn <cr> XSn <cr> Send stored serial command to the local RS232 port.   
n = 1 - 6 = Location of stored serial command 

AMn <cr> AMn <cr> Set auto mode 
n = 0 – 1 = Manual – Auto 

ODn <cr> ODn <cr> Set auto off delay 
n = 0 – 240 (in minutes) 

FD <cr> FD <cr> Perform a factory default.   
FW <cr> FWx.x <cr> Read firmware version.   
NOTE: If n is not specified in any of the commands above, the command becomes a query command 
instead of a set command.  In response to a query command, the system reports the current status of that 
command. 
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